
Writing Neat-looking Letters? Give them
Neat-looking Envelopes to Match!

With Microsoft Word, letter-writing is a doddle. It takes
almost no effort to write a formal letter that looks smart
and neat. But when it comes to the envelope, many of us
spoil the effect by writing the address by hand.

Perhaps we’re not sure where to start, or we’re not even
aware that Word can handle envelopes too. It certainly
can, and in this article I’ll show you how to produce an
envelope as smart as the letter inside it. I’ll also show you
how to save and reuse a special ‘envelope document’ that
makes all future envelope printing quick and simple.
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This article shows you how to:

� Print smart envelopes quickly whenever you need them

� Set up and print an envelope in Microsoft Word

� Save a pre-prepared ‘envelope document’ for easy reuse
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Two Things to Check Before You Start  
There are a couple of things you’ll need to know during the
setup of your envelope, and it makes sense to sort those out
in advance if you can:

•  What size envelope are you using, and is it compatible
with your printer? For ordinary letter-writing on A4
paper, you’re probably using the standard ‘DL’ envelope,
which is roughly the same width as the paper and one
third its height (taking a sheet of A4 folded twice).
Assuming that’s the case, there’s nothing else to check –
your printer is certain to handle DL envelopes. 

   However, if you think you might be using a different-size
envelope, check its name and/or dimensions because
you’ll need to know these a little later. It would also be
worth making sure your printer is compatible with these
envelopes: your printer’s manual should list the various
types and sizes of paper, card and envelopes it can
handle.

•  How should envelopes be inserted into your printer?
Perhaps surprisingly, Microsoft Word itself should be able
to tell you how to insert blank envelopes into your printer
– face up or face down, short edge first or long edge first,
and so on – and I’ll show you how to check this
information along the way. 

Nevertheless, if you have your printer’s manual handy, it
would be worth having a look at its section on envelope
printing to see if there’s anything else worth knowing. Some
printers have a separate ‘envelope tray’, for instance, and
insist that you place the envelope in that rather than the
usual paper tray. Since envelopes have gummed flaps or self-
seal strips which could get caught up in the works, it pays
to know how your printer wants things to be done!

Word: Print Envelopes Easily W 532/2
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Step by Step: Setting Up Your Envelope
Have you just finished writing and printing a letter? That’s
the most common time you’d need an envelope, in which
case Microsoft Word is already running and your printer is
already switched on. If so, follow these few quick initial steps:

W 532/3
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Getting started

Later on in this article, I’ll give you a handy tip which
ensures that this ‘how to insert’ information is always
right under your nose whenever you need to print an
envelope in future, saving you the need to reach for your
printer’s manual every time! 

1.  If you’ve typed the recipient’s name and address at
the top of your letter, you may like to highlight it and
press + to copy it to the clipboard. (This
doesn’t matter too much, but it will save you having
to type it into your envelope later on.)

2.  If you haven’t saved your letter and you want to keep
a copy, do that now.

3.  Close your letter by pressing + , then create
a new blank document by pressing                  .

Perhaps you haven’t just written a letter. In that case,
follow these few steps to get started:

1.  Switch on your printer.
2.  Start Microsoft Word.
3.  In Word 2010 you’ll immediately be looking at a new

blank document, which is exactly what you want. In
Word 2013 or later you’ll probably arrive at the ‘Start
screen’ instead: on this screen, click on Blank docu-
ment to generate a new empty document.

Ctrl C

Ctrl W

:

:

+ Ctrl N
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1.  Switch to the Mailings tab on Microsoft Word’s
Ribbon .

2.  In the ‘Create’ group at the far left, click the Envel-
opes button .

3.  Now you’ll see the ‘Envelopes and Labels’ dialog
pictured in the screenshot on the opposite page. Click
in the large box at the top headed Delivery address

and either type the name and address of the
letter’s recipient or, if you followed my earlier advice
of copying those details to the clipboard from your
letter, just press + to paste them into the
box. (Don’t worry if the font looks unusual or the text
size is larger or smaller than you’d like, we’ll sort
those details out later.)

1

2

3

Ctrl V

Word is running
and your printer
is on

Type or paste 
the recipient’s
address
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Now, whatever you were just doing, you’re looking at a
blank document in Word, your printer is switched on and
waiting expectantly, and you’re ready to set up your
envelope. Here are the steps to follow:

:

Perhaps at this stage you don’t actually need to print an
envelope, but you’d like to set up the ‘envelope
document’ I mentioned earlier so that you’ll have it to
hand whenever you do need one? If so, just type
anything address-like into this box as a placeholder –
your own address perhaps, or a fictitious one.

2

1
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4.  Now we reach the smaller box below, headed Return
address, and here you have a choice. In some
countries it’s traditional to include your own address
in the top-left corner of the envelope – rather a good
idea, but one that’s never caught on here in the UK.
It’s up to you whether you do this or not. If you
would like to do it, type your own name and address
into this box and make sure there’s no tick in
the Omit box ; if you’d prefer not to, tick the Omit
box       instead.

5.  Next we need to check (and perhaps change) the
settings for our envelope, so click the Options button

. This opens a dialog titled ‘Envelope Options’.
6.  The most important thing to check in this dialog is

the Envelope size box at the top : does it show
the size of envelope you’re planning to use? If not,
open the drop-down list and choose the correct size
and/or name (such as DL).

4

6
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5
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4
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7.  A little lower down you’ll see two Font buttons, one
to set the font for the delivery address and one
for the return address       . If you’re not keen on the
font and/or text size that was used for either or both
of these addresses when you typed them earlier, click
these buttons to change them. In each case, a Font
dialog will appear in which you choose the font
settings you want and then click OK.

8

It’s best to use the same font for both addresses and to
pick an easily-readable font such as Calibri, Verdana,
Tahoma or Arial. A size of 10 or 11 should be fine for
the delivery address; the return address (if you chose to
include it) should be smaller, at about 7 or 8.

In both cases, stick to the ‘Regular’ font style rather than
bold or italic, leave the font colour as ‘Automatic’ and
don’t use any of the underlining options or text effects.

8.  Now switch to the Printing Options tab of this dialog
. I mentioned earlier that Word usually knows how

envelopes should be inserted into your printer, and this
tab tells you how Word is expecting to print them:

10

8

9

7

9
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edge first?

Printer tray

•  The six little icons below Feed method tell you whether
a long edge or short edge feeds into the printer, and
whether the envelopes should be at the left, centre or
right of the tray. One of these icons will have a selection
box around it , indicating that this is the method
Word is expecting you to use.

•  Below this, Word tells you whether the envelope should be
face up or face down when you place it in the tray .

•  The Clockwise rotation checkbox applies only if a
short edge of the envelope feeds into the printer. If
ticked, the envelope should be turned with the flap to the
right; if not ticked, the flap should be to the left.

•  The Feed from box tells you which of your printer’s
trays should be used to insert envelopes.

A

B

C

D

If you’ve looked at your printer’s manual, you should
find that this information tallies with what you read
there. If it doesn’t, it’s best to assume the manual is
correct and change these options to match it. If you haven’t

10

A

B
C

D
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checked the manual, however, don’t worry: make a
mental note of how Word tells you to insert the enve-
lope here, and we’ll see if it works later!

9.   Click the OK button at the bottom of this ‘Envelope
Options’ dialog.

10. This takes you back to the larger ‘Envelopes and
Labels’ dialog you were using earlier. At the bottom
of this dialog, you’ll see a tempting-looking ‘Print’
button, but we’re going to ignore that. At this stage,
we don’t know quite how the envelope looks – you
may want to adjust the fonts, text sizes, and
positioning of the addresses – and you may also
want to take up my suggestion of saving a ready-
to-print ‘envelope document’ to make all this
simpler in the future. Therefore, click the Add to
Document button .

11. As soon as you click the Add to Document button,
you may see the question pictured below. This only
appears if you chose to include your return address
on the envelope in step 4 above. Word is offering to
store your address and insert it into that box for you
automatically in future. It makes sense to say Yes,
but it may not matter: if you take up my suggestion
of saving an ‘envelope document’ for future use,
you’ll rarely (if ever) have to navigate these dialogs
again anyway.

11
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How Does it Look? Try a Test Print
This new ‘envelope page’ should be laid out neatly enough
(there’s not a lot to it, after all!), but this is the first time
you’ve seen it after choosing fonts and text sizes. Perhaps
you can tell straight away that the text size of the delivery
address is too small, or the size of the return address is too
big? Or perhaps you wish you’d chosen a different font?

12. Now you’re returned to your Word document where
you’ll see that, above the blank A4 page you started
with, a new envelope-shaped page has appeared
containing the address details you entered.
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Need to move
the delivery
address?

Try printing your
envelope
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If so, that’s easy to put right. Highlight the address you want
to change, switch to the Home tab of the Ribbon and use
the usual options in the ‘Font’ group to make any changes
you like, just as you do in any other Word document.

One thing you’ll notice if you highlight the delivery address
is that a dotted outline appears around it. This is because
Word has placed this address into a text box. If you do
change the font or text size of this address, you may feel
that the address is now a little too far to the left or right on
the envelope. Again, that’s easily fixed: move your mouse
pointer on to the top edge of the dotted box, which causes
the pointer to gain a crossed-arrow shape. When it does,
press and hold the left mouse button and drag this text box
to wherever you’d like it positioned on your envelope.

Now, as far as you can tell, the envelope looks as it should,
so let’s try printing it. This is partly to check the layout on
paper (although it should exactly match what you see on the
screen) and partly to check whether envelopes really should
be inserted into your printer the way you think they should!

Insert a blank envelope into your printer the way you
believe it should be done and then follow these steps:

1.  Click the File tab at the far-left of the Ribbon and
choose Print or, more simply, press + .

2.  Now there’s an important change to make. At the
moment the document consists of two pages – the

Ctrl P:
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Tell Word to
print the first
page only!

Click Print

All correct?

    envelope and the currently-blank A4 page below it
– and we only want to print the envelope. In the
‘Settings’ section of the Print screen that has
appeared, click in the box beside Pages and type 1
(the number one) to tell Word to print only the first
page of the document.

3.  If you want to adjust your printer’s settings (perhaps
to change the print quality), click the Printer
Properties link a little higher up and do that, clicking
OK afterwards.

4. Finally, click the large Print button at the top-left of
this Print screen to print your envelope. As this
happens, the Print screen disappears and you’ll
return to your document.

How has it turned out? Hopefully everything has gone
according to plan and – crucially – the addresses are on the
front of the envelope, not the flap, and the right way up! If
so, you’ve produced a useable envelope and you can pop
your letter into it.

But perhaps things have gone haywire. You may discover that
you actually needed to insert the envelope the other way up
(or the other way round). If so, you’ve sacrificed an envelope,
but at least now you know how to insert it in future!

Besides the basic question of whether the envelope was
inserted correctly, you can now see how the fonts and
the positioning of the delivery address look. If you want
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Save Your Envelope to Reuse in Future
At this stage, you have an envelope on the screen in front
of you which looks as it should, and you’ve also printed
an envelope to use (if you needed one). You could simply
close this document and/or close Microsoft Word and call
the job done.

However, that would leave you repeating similar steps next
time you need an envelope, and there’s no need to go to all
that trouble. A more practical option is to save this
document so that you can use it again.

Before you do this, here’s the quick tip I mentioned earlier.
Below our envelope page in Word there’s a blank A4 page.
We’ll never want to print that page, but we can put it to
good use. At the top of that page, type a sentence or two
which tells you how to insert envelopes into your printer.
This way, whenever you print an envelope in future, you’ll
have this information right in front of you to ensure you
get it right first time!

Word: Print Envelopes Easily W 532/12
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to make changes now, you can do so on the Home tab
of the Ribbon as I mentioned on page 10. 
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Now you’re ready to save the document. Press the key
on your keyboard, which displays the Save As dialog. In
this dialog, navigate to the folder in which you want to save
this document. The dialog is probably showing your
Documents folder initially, and that’s a good enough place,
but you may prefer to save it elsewhere (or you may like to
create a new folder named ‘Envelopes’ to keep all your
envelopes together and make them easy to find if you decide
to use the extra tip I mention on page 14).

Type a name for this document, the obvious being ‘Envelope’,
and then click the Save button.

That’s it – you’re done, and you can close this document (by
pressing + ) and work on something else, or close
Microsoft Word.

Quickly Print an Envelope When Needed
To set up and print your first envelope, you followed a total
of 16 steps and had to dodge your way through several
dialogs to produce a single printed envelope. You can do all
that again next time you need one, but hopefully you
followed my advice of saving the finished result for reuse.

If you did, you can follow these few simple steps each time
you need to print an envelope in future:

Ctrl W

F12

1.  Start Microsoft Word. In Word 2019, click on Open
then Browse. In Word 2016, click on Open other
documents then click Browse. In Word 2013, click
on Open other documents followed by Computer
and then Browse. In Word 2010, click the File tab
followed by Open.

2.  Navigate to the folder in which you saved your
‘Envelope’ document and double-click it to open it.

:
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Save Envelopes for Frequently
Used Addresses!
You can see straight away that the steps for printing future
envelopes are far quicker than those for creating your first
envelope, thanks to having saved that ‘envelope document’.

However, why not speed things up a little more? If there are
people you write to regularly, save their ready-made
envelopes too! After typing someone’s name and address
into this document, press to display the Save As dialog
and save the document with a name like ‘Envelope, John
Smith’ or ‘Envelope, Lloyds Bank’.

This way, next time you write to one of these people again,
you can simply open their personal ‘envelope document’ and
go straight to printing its first page. Admittedly this uses
more space on your hard disk, but even 100 of these
envelope documents would use very little – and this kind of
time-saver is an ideal way to use that space anyway!

F12
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3.  When the document appears in front you, highlight
the delivery address it currently contains and then
type (or paste from the clipboard) the new name and
address you need for this envelope.

4.  Insert a blank envelope into your printer’s tray
(perhaps using the note you typed into the A4 page
of this document to jog your memory about how to
do that!).

5.  Choose File > Print or press + to go to the
Print screen. As you did on page 11, click in the
Pages box and type the number 1 (to ensure you
print only the first, envelope-shaped page), adjust
your printer’s settings if necessary and click Print.

Ctrl P
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